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Chapter 1

What is ArcSight Express All-in-One?

ArcSight Express All-in-One is a Security Information and Event Management (SIEM) 
solution that provides the essentials for security monitoring by leveraging ArcSight ESM’s 
superior correlation capabilities in combination with ArcSight Logger as storage component 
within a single appliance. The ArcSight Express All-in-One appliance delivers an 
easy-to-deploy enterprise-level security monitoring and response system through a series 
of coordinated resources, such as dashboards, rules, and reports included as part of 
ArcSight Express Content.

This chapter covers the following topics:

“Pre-installed Components on ArcSight Express All-in-One” on page 2

“ArcSight Console” on page 4

“Deployment Overview” on page 4

“ArcSight Express All-in-One Communication Overview” on page 5

“Related Documents” on page 7
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1 What is ArcSight Express All-in-One?
Pre-installed Components on ArcSight Express 
All-in-One

ArcSight Express is pre-installed with the following software components:

ArcSight ESM Manager

ArcSight Database

ArcSight Web

ArcSight Forwarding Connector

ArcSight Logger and two default containers, each one supporting four connectors to 
total eight connectors

ArcSight Threat Response Management (TRM)

ArcSight IdentityView Express

ArcSight SmartConnector for Microsoft Active Directory Actor Model Info 

ArcSight ESM Manager
ArcSight ESM Manager is at the center of ArcSight Express All-in-One. ESM Manager is the 
server that receives event data from SmartConnectors, and correlates and stores them in 
the database. ESM Manager also provides advanced correlation and reporting capabilities. 
The ArcSight Web interface is used to retrieve this information from ESM Manager and 
display it.

ArcSight Database
ArcSight Database is the central repository for all information collected by ESM Manager 
and is based on Oracle DBMS. It also stores the configuration information for users, 
groups, rules, dashboards, assets, and reports. 

ArcSight Web
ArcSight Web is the primary user interface for ArcSight Express All-in-One. ArcSight Web is 
a web server component that enables you to access ESM Manager securely using a 
browser. ArcSight Web supports the following browsers on the Windows Vista or Windows 
XP platforms:

Internet Explorer 6 and 7

Firefox 2.0 - 3.0

ArcSight Web is an easy-to-use interface designed for operators in a Security Operations 
Center (SOC) and customers of a Managed Security Service Provider (MSSP) who need to 
view information on ArcSight ESM Manager. 

Check the Product Lifecycle document available on the ArcSight Customer 
Support website for information on the exact browser versions supported.
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1 What is ArcSight Express All-in-One?
ArcSight Logger
ArcSight Logger is a log management solution that is optimized for extremely high event 
throughput. Logger stores time-stamped text messages, called events, at high sustained 
input rates and can optionally forward selected events. Logger compresses raw data, but 
can always retrieve unmodified data on demand, for forensics-quality litigation data.

ArcSight Connector Management
ArcSight Connector Management software incorporates a number of onboard ArcSight 
SmartConnectors and a web-based user interface that provides centralized management 
for SmartConnectors.

SmartConnectors are ArcSight software components that forward security events from a 
wide variety of devices and security event sources to various destinations.

ArcSight Express All-in-One supports a total of eight SmartConnectors (four per container). 

ArcSight Forwarding Connector
The ArcSight Forwarding Connector is a component that transports events from ESM 
Manager to a destination, in this case, to Logger. 

ArcSight Threat Response Management
The ArcSight Threat Response Management (TRM) component enables you to respond 
quickly to cyber-security incidents detected on the network. 

IdentityView Express
IdentityView is an ArcSight solution that provides Privileged User and Shared Account 
monitoring capabilities. IdentityView works with Microsoft Active Directory for user 
management.

ArcSight SmartConnector for Microsoft Active Directory 
Actor Model

This ArcSight SmartConnector extracts the user identity information from an IDM database 
and populates the Actors resource in ArcSight’s ESM Console with this data. The Actors lists 
are populated and updated dynamically as changes are made in Active Directory.
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1 What is ArcSight Express All-in-One?
ArcSight Console
The ArcSight Console provides a user interface for you to perform administrative tasks on 
ArcSight Express All-in-One, such as fine tuning the pre-installed ArcSight Express Content 
and managing users. ArcSight Console is not bundled with ArcSight Express and should be 
separately installed on a system other than the ArcSight Express All-in-One appliance.

Deployment Overview
The following is an example of how various ArcSight components are normally deployed in 
a network. 

Figure 1-1 ArcSight Express All-in-One Deployment Overview
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1 What is ArcSight Express All-in-One?
ArcSight Express All-in-One Communication Overview
ArcSight Console, ArcSight ESM Manager, and ArcSight SmartConnector communicate using 
HTTP (HyperText Transfer Protocol) over SSL (Secure Sockets Layer), often referred to as 
HTTPS (HyperText Transfer Protocol Secure). The HTTPS protocol provides for data 
encryption, data integrity verification, and authentication for both server and client.

Figure 1-2 ArcSight Express All-in-One Solution - Communication Overview

SSL works over TCP (Transport Control Protocol) connections. The default incoming TCP 
ports are as follows:

ArcSight ESM Manager = 8443

ArcSight Web = 9443

ArcSight Logger = 443

ArcSight TRM = 1443

ESM Manager never makes outgoing connections to the Console, ArcSight Web, or 
SmartConnectors. ESM Manager connects to the Database on the appliance locally using 
JDBC.
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Effect on Communication if Components Fail 
Events are collected by one or more SmartConnectors and sent to ArcSight ESM. From 
ArcSight ESM, the Forwarding Connector sends these events to Logger for storage.

Figure 1-3 ArcSight Express All-in-One Event Flow

If any one of the software components in ArcSight Express All-in-One is unavailable, it can 
affect communication between other components. 

If the database is unavailable for any reason, such as when database is filled to capacity, 
ESM Manager stops accepting events and caches any events that were not committed to 
the database. The SmartConnectors also start caching new events they receive, so there is 
no event data loss. The Console gets disconnected. All existing ArcSight Web connections 
are disconnected and no new login requests to the Web server are accepted until the 
database is up and running again. 

If  ESM Manager is unavailable, the SmartConnectors start caching events to prevent event 
data loss. The database server is idle. The Console is disconnected. All existing ArcSight 
Web connections are disconnected and no new login requests to the Web server are 
accepted. 

If a SmartConnector fails, whether event data loss will occur or not depends on the 
SmartConnector type. SmartConnectors that listen for events from devices such as the 
SNMP SmartConnectors will stop accepting events. However, a SmartConnector that polls a 
device, such as the NT Collector SmartConnector, may be able to collect events that were 
generated while the SmartConnector was down, once the SmartConnector comes back up.

If the Forwarding Connector fails,  ESM Manager will continue to store the events in its file 
store which is 10 GB in size. If the file store fills up,  ESM Manager will start dropping the 
oldest events and the newer events will continue to get stored on the file store.

If Logger fails, the Forwarding Connector will cache the events that were supposed to be 
forwarded to the database. 
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Related Documents
To get you started, the Getting Started with ArcSight Express All-in-One document is 
available in hard copy and is packaged with the ArcSight Express All-in-One appliance. 

The Online Help is available from the ArcSight Console (installed in a separate system). In 
addition to this guide, you can download and refer to the following documents from the 
ArcSight Customer Support download site.

For ArcSight Express All-in-One:

Getting Started with ArcSight Express All-in-One

ArcSight Express All-in-One Release Notes

ArcSight Express Content Guide 

For ArcSight ESM Manager:

ArcSight ESM Installation and Configuration Guide

ArcSight ESM Administrator’s Guide

ArcSight ESM Release Notes

ArcSight ESM User’s Guide or Console Help 

For ArcSight Logger and Connector Management:

ArcSight Logger Administrator’s Guide

SmartConnector User’s Guide

ArcSight Connector Appliance Administrator’s Guide

ArcSight Connector Appliance Release Notes 

For ArcSight Forwarding Connector:

SmartConnector Configuration Guide for ArcSight Forwarding Connector  

For ArcSight Threat Response Management:

ArcSight NSP Installation and Administration Guide

You will refer only to the Threat Response Management chapter.

ArcSight NSP Release Notes 
ArcSight Connector Appliance Administrator’s Guide

ArcSight Connector Appliance Release Notes

SmartConnector Configuration Guide for ArcSight Threat Response Manager 

Important: When you are referring to the individual documents listed here, 
please realize that the ArcSight software components in ArcSight Express 
All-in-One can also be purchased individually in their own appliances. For 
purposes of ArcSight Express All-in-One, the setup is different than setup for 
individual appliances. You should first refer to this Configuration Guide for 
setup guidelines, then refer to specific topics in the other documents when 
this guide directs you to do so.
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For IdentityView and Active Directory Model Import Connector:

ArcSight Deployment Guide, IdentityView Express

ArcSight IdentityView Express Release Notes

ArcSight SmartConnector Configuration Guide for Microsoft Active Directory Actor 
Model

Release Notes, SmartConnector for Microsoft Active Directory Actor Model

ArcSight Solution Guide, IdentityView
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Chapter 2

Configuring ArcSight Express All-in-One

This chapter covers the following topics:

The steps in this chapter presume that you have performed the following:

Completed ArcSight Express All-in-One installation by following the instructions in the 
Getting Started with ArcSight Express All-in-One document. We recommend that you 
read the ArcSight Express All-in-One Release Notes before proceeding.

Obtained the required license from ArcSight Customer Support and followed 
instructions on where to store the file. This single file is good for all software 
components in the appliance.

“Configuration Overview” on page 10

“Configuring the Operating System” on page 10

“Configuring ArcSight ESM” on page 21

“Copying the CA Certs File” on page 28

“Configuring ArcSight Logger” on page 29

“Configuring ArcSight Forwarding Connector” on page 32

“Configuring ArcSight Threat Response Management (TRM)” on page 33

“Configuring ArcSight IdentityView Express and Active Directory Model Import 
Connector” on page 33

“Next Steps” on page 34
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2 Configuring ArcSight Express All-in-One
Configuration Overview
Configuring ArcSight Express All-in-One includes the following process:

1 Configuring the Oracle Enterprise Linux operating system installed on the appliance

2 Configuring the ArcSight ESM (includes Database, Manager, and Web) using First Boot 
Wizard

3 Configuring ArcSight Logger

4 Configuring the ArcSight Forwarding Connector

5 Configuring additional software components

Configuring the Operating System
ArcSight Express All-in-One has the Oracle Enterprise Linux operating system installed. Set 
up the preferences for Oracle Enterprise Linux when you boot the system for the first time 
only or when you boot the system after a factory restore. 

The following wizard will help you set the preferences for Oracle Enterprise Linux:

1 Click Next on the Welcome screen:

ArcSight Express All-in-One is composed of multiple ArcSight software 
components and each component comes with its own set of documents. 
Those documents reflect the installation and use as standalone products and 
provide a level of detail not covered in this chapter. The procedures in this 
chapter will direct you to the applicable ArcSight document at the appropriate 
stage of the configuration. However, due to specific requirements of 
ArcSight Express All-in-One, you may be asked to change the sequence of 
some standard setup steps or use settings specific to ArcSight Express. These 
exceptions will be pointed out to you as required.
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2 Configuring ArcSight Express All-in-One
2 Read the license agreement.This license agreement is for Oracle Linux. Select Yes, I 
agree to the License Agreement if you agree with it:

3 Click Next.

4 Select the Keyboard you will be using:

5 CLICK Next.
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2 Configuring ArcSight Express All-in-One
6 Select your mouse configuration:

7 Click Next.

8 Enter a password for the root account which is used for system administration. 
Re-enter to confirm it:

9 Click Next.
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2 Configuring ArcSight Express All-in-One
10 Most components, including ESM Manager and ArcSight Web, run using an "arcsight" 
user account for security reasons. The “arcsight” user account has already been 
created for you. Set up a password for the user “arcsight” in the following screen:

11 Click Next.

12 Oracle runs as the user “oracle”. Set up a password for the Oracle user “oracle” in the 
following screen:

13 Click Next.

The next step is to configure the IP address for the appliance. The appliance is set up 
with the following pre-defined IP addresses:

192.168.35.35 for eth0 

192.168.36.35 for eth1 

When setting up the IP address in the next steps, make sure to use an available IP 
address in your production environment.
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2 Configuring ArcSight Express All-in-One
14 On the Network Setup screen, select the eth0 interface:

15 Click Change Network Configuration... 

a Click the DNS tab in the Network Configuration dialog and enter a host name, 
DNS servers, and DNS search path (domain name) for ArcSight Express:

b Click File->Save to save the changes.

For the Network Configuration screens that appear, please note that if 
you click on the wizard screen while the network setup dialog is in the 
foreground, the network dialog disappears and the wizard buttons 
remain inoperable. Use Alt-Tab to switch back to the network setup 
dialog.
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2 Configuring ArcSight Express All-in-One
c Click the Devices tab. Deselect eth1, eth2, and eth3. Select eth0 and click the 
Edit button:

d Set the IP address, subnet mask, and default gateway in the Ethernet Device 
dialog:

Make sure that you do not change the default values in the Hosts tab 
of the panel shown above. If you change the default values, it could 
lead to loss of network connectivity and you will receive this error:

Could not look up internet addresses for <hostname>.This 
will prevent GNOME from operating correctly.

ArcSight recommends that you configure a single network interface, 
eth0, and disable the rest to avoid networking problems. For 
example, if you configure eth1, ESM Manager will not be able to 
communicate with the database.  
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2 Configuring ArcSight Express All-in-One
Important: Make sure that the IP address you set up is not already in use. First 
Boot Wizard will report errors if the IP address has not been configured correctly.

e Click OK.

f Click File->Save to save the settings. If you exit the dialog without explicitly 
saving, you will get a prompt asking you if you want to save the changes. Click 
Yes in the Information box.

The Network will automatically be restarted and you will see a message, 
"Restarting network. Please wait...".

g Click File->Quit to exit the Network Configuration dialog.

h Click Next in the Network Setup dialog.

16 Choose Disable firewall in the Security Level dropdown menu and then make sure 
the ports listed in the note below are open:

If you want to change the host name or IP address after you have 
finished running this wizard, you will have to do a system restore. 
The system restore will run First Boot Wizard and you can make the 
changes you want in the wizard. See Appendix C‚ Restoring Factory 
Settings‚ on page 79 for details.

Make sure that the ports 8443 and 9443 are open for outgoing 
communications. ArcSight Manager uses port 8443 and ArcSight Web 
uses port 9443 for communication. You will also need to leave port 22 
open for remote ssh access. 
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2 Configuring ArcSight Express All-in-One
17 Click Next.

18 Select the Timezone in which your appliance is located. 

19 Click Next.

By default, Network Time Protocol (NTP) is active. The system will attempt to contact 
the NTP servers. It could take a few minutes to contact a server. If the system cannot 
contact a server, the request will time out in a few minutes and will take you to the 
next screen in the wizard.

NTP requires three or more servers to work correctly. The list of servers configured by 
default points ArcSight Express to a virtual cluster of time servers operated by the NTP 
project. Assuming that UDP port 123 is open to the outside internet in your firewall, 
you can keep the default values, unless you would prefer to use your own cluster of 
NTP servers.
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2 Configuring ArcSight Express All-in-One
By default, the Enable Network Time Protocol checkbox is checked (recommended). 
This will configure the operating system to use the NTP servers specified in the list 
from which to obtain the time. 

ArcSight strongly recommends using NTP because accurate time 
keeping is essential for event correlation and log management.

 

If you choose to de-activate the Network Time Protocol, make sure to set the local 
date and time in the Date & Time tab:

20 Click Next. 
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2 Configuring ArcSight Express All-in-One
A message states that the NTP server is being contacted.

21 Click Next.

22 Select the resolution and color depth for your screen.

23 Click Next.

You have completed the NTP setup in this configuration phase. ArcSight 
strongly recommends that you do not set up NTP in Logger even when 
prompted. When Logger displays a message about this, ignore the 
reminder. Click the link on the reminder, which displays the Logger’s 
Settings page. Exit from that page without entering NTP settings.  
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2 Configuring ArcSight Express All-in-One
24 Click Next in the following screen: 

You are prompted to enter your username in a login screen. Here, the second phase of 
the First Boot Wizard begins. This phase will help you configure ArcSight ESM.

25 Important! Log in as user root when you are prompted with the screen below:
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2 Configuring ArcSight Express All-in-One
26 Enter the password for this account which you had set in Step 8 on page 12:

After you have logged in successfully, the software components configuration wizard 
opens. Follow the directions in the Configuring ArcSight ESM section to configure ArcSight 
ESM.

Configuring ArcSight ESM
The wizard continues from the operating system setup to the following screen:

At this stage of the setup, you will configure ArcSight ESM which includes the database, 
ArcSight ESM Manager, and ArcSight Web.
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2 Configuring ArcSight Express All-in-One
1 On the first screen after logging in as root, the wizard reminds you to configure the 
Storage Appliance before configuring ArcSight Express. Ignore this reminder for now 
and click Next.

2 Select the language for the user interface display:.

3 Click Next.

 Restarting this wizard if you exit it...

If you exit any of the following screens, the wizard will exit with the following 
warning:

The wizard is not finished yet. Are you sure you want to exit?

You can re-start the wizard at any point until you get to the screen which tells 
you that the Manager configuration has been completed. To re-start the 
wizard, run the following command as root from the directory, 
/opt/arcsight/manager/bin:

./arcsight appliancefirstbootsetup

The wizard will open the screen you see in Step 1 below.

ArcSight Express is functional only after the successful completion of the 
wizard.
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2 Configuring ArcSight Express All-in-One
4 The database user account has already been created for you with username “arcsight”. 
Enter a password for this account:

5 Click Next.

6 Enter passwords for the SYS and SYSTEM accounts.

Oracle SYS Password—Password for the Oracle superuser, SYS. 

Oracle SYSTEM Password—Password for the Oracle admin account. 

7 Click Next.
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2 Configuring ArcSight Express All-in-One
8 Configure the following e-mail addresses: 

Notification e-mail address: An e-mail address of the person who should receive 
e-mail notifications in the event that the ArcSight Manager goes down or encounters 
some other problem.

Escalation e-mail address: An e-mail address of the person who should receive an 
escalation e-mail in case no action has been taken for a period of time after the 
notification e-mail was sent.

From Address: E-mail address that will be used to represent the sender of the e-mail 
notifications.

9 Click Next. 

10 Enter or navigate to the location where you have stored the ArcSight Express license 
file:

The license file is applicable to all software components bundled in ArcSight Express 
All-in-One. In the future, if you are referring to the individual documents about these 
components and a separate licensing requirement is mentioned, note that those 
licenses apply only if the software components are purchased individually.
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2 Configuring ArcSight Express All-in-One
If you do not have a license file, contact ArcSight Customer Support to obtain one. You 
can use the Web browser on the appliance to download the file once you obtain it from 
ArcSight Customer Support. Alternatively, you can download the license file elsewhere 
and use scp or sftp to access the appliance.

11 Click Next.

12 Enter the Manager’s host name and other information which will be used to create an 
ArcSight Manager user with administrative privileges. 

Important: Make sure to change the Manager Host Name to either the host name 
or IP address of the ArcSight Express All-in-One appliance. The Manager host name 
setting will be used to generate a self-signed certificate and also when the Console 
connects to the Manager. You specified this host name during network configuration in 
Step 15 on page 14.

The Common Name (CN) in the certificate will be the Manager host name that you 
specify in this screen:

13 Click Next.

14 Select Do not forward events to ArcSight Storage Appliance.
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2 Configuring ArcSight Express All-in-One
Select this setting because ArcSight Logger is not yet configured.

15 Click Next.

The next screen informs you that ArcSight Express is ready to be configured. 

16 Click Next.

During the configuration process, the following informational message appears:

17 Ignore this message and click OK to continue.

As the configuration process continues, you can see the progress and errors if any. 

If you see a “Failed” status on any listed task, or if you exit this wizard 
while it is still configuring the components, you are required to manually 
configure the failed component and manually perform the rest of the steps 
shown in the screen capture above. See “Failed” Status while Configuring 
or Starting a Component section in the Appendix A‚ Troubleshooting‚ on 
page 59 for detailed steps on how to do this.
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You cannot restart the wizard after the Manager configuration has started.

Keep in mind that if you exit the wizard while it configures the software 
components, or if an error occurs, you will have to configure components 
manually. See Appendix A‚ Troubleshooting‚ on page 59 for detailed steps 
on how to do this.

18 After the configuration completes successfully, click Next.

A message states that the tablespace expansion is in progress.
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Allow time for the process to be completed. After your appliance has been configured 
successfully, the wizard displays the following screen:

19 Click Finish.

Proceed to Copying the CA Certs File.

Copying the CA Certs File
The following procedure will help you copy the CA Certs file to the different Connector 
directories and specify “arcsight” as the owner of the directories. A script is provided to 
accomplish this task. 

To copy the CA Certs file:

1 Run the following command:

/root/bin/addCerts.sh

2 Change the ownership of the files to the “arcsight” user:

# chown arcsight:arcsight 
/opt/arcsight/connector_esm/current/jre/lib/security/cacerts

Proceed to Configuring ArcSight Logger to set up ArcSight Logger and define storage 
volume.

Do not copy CA Certs into the onboard Logger connector directory which 
is in /opt/arcsight/connector. This connector is for connecting to an 
external ESM Manager installation and is not configured for 
ArcSight Express All-in-One use. Doing so will result in an infinite loop.
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Configuring ArcSight Logger
ArcSight Logger is pre-installed in ArcSight Express All-in-One. After setting up ArcSight 
ESM, you will next set up Logger. Refer to this section for the high level sequence and 
specific settings, then refer to the initialization-related topics in the ArcSight Logger 
Administrator’s Guide as required.

In ArcSight Express All-in-One, Logger is pre-configured with two containers (on the 
Logger UI, view them by selecting Configuration > Manage Connectors). ArcSight 
Express supports a maximum of eight SmartConnectors, four SmartConnectors per 
container.

Logger Configuration Notes
Read the following important considerations before configuring Logger in ArcSight Express 
All-in-One:

Logger reboots: During Logger configuration, Logger will always remind you to 
reboot. Ignore these reminders and postpone rebooting until the end of Logger setup.

Ignoring NTP Setup in Logger: You have already set up NTP during the OS 
configuration phase. ArcSight strongly recommends that to avoid conflict, do not set 
up NTP in Logger. When Logger displays a message about this, ignore the reminder. 
Click the link on the reminder, which displays the Logger’s Settings page. Exit from that 
page without entering NTP settings.  

Remote access to Logger: ArcSight recommends that you configure Dell Remote 
Access Controller (DRAC) to enable remote access to Logger in the ArcSight Express 
All-in-One appliance. Contact ArcSight Customer Support for details.

Logger configuration sequence: It is very important that you initialize Logger in 
the sequence shown here. Logger can be reset to its initial condition, but other than 
that, several of the settings described here cannot be changed once they are set.

a Configure Permissions for “arcsight” User

b Define Storage Volume - establish where Logger stores event data

c Create Storage Groups - apply retention policies to the Storage Volume

d Configure Indexing - select fields without enabling full-text search

e Reboot Logger - reboot to make your storage settings take effect

f Create SmartMessage Receivers - specify the receiver type

If you plan to configure Event Archives in Logger, you should use a remote 
mount such as NFS or CIFS to archive your events.  The Event Archives 
Storage Settings can be configured in the Logger UI at Configuration > 
Settings > Event Archives > Archive Storage Settings. 

One-time initialization can only be changed by performing a factory reset 
(see Appendix C‚ Restoring Factory Settings‚ on page 79). Be sure you 
know your required Logger setups before performing the first steps of the 
initialization sequence (up to rebooting).
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Configure Permissions for “arcsight” User
By default, ArcSight Logger uses the “oracle” user as the owner of the Logger directory. 
ArcSight Express All-in-One requires “arcsight” to be the owner. If ownership is not 
changed, Logger will display an error message at the time you are configuring Storage 
Volume (see Define Storage Volume). The message will state:

Cannot write to /opt/data/logger

To change ownership:

As root, enter this command:

chown -R arcsight:arcsight /opt/data/logger

This grants the “arcsight” user permission to define storage volume in Logger, as described 
in Define Storage Volume. After changing the owner, Logger no longer displays the error 
message.

Access the Logger User Interface
Refer to the ArcSight Logger Administrator’s chapter on Installation and Initialization and 
follow the procedures on how to use a browser to set the IP address. Remember:

Use the same IP address you configured for ArcSight Express All-in-One during setup 
beginning on Step 14 on page 14.

https://<ArcSight Express ip address>

Use the default user name and password provided with Logger.

Define Storage Volume
Establish the Logger’s Storage Volume. See the section on Storage Volume in the ArcSight 
Logger Administrator’s Guide for details. Use the following settings:

Choose Local to use Logger’s built-in storage.

Set the maximum size to 1024 GB.

Set the pre-allocation amount to no less than 100%.

Performance is degraded if you don’t pre-allocate at least a portion of the storage 
volume. ArcSight recommends 100% pre-allocation for your Storage Volume. 

Storage Volume cannot be extended after initialization.

Create Storage Groups
After you create the Storage Volume, define the Default Storage Group. ArcSight 
recommends that you increase the maximum size of the storage group and increase the 
maximum age of the event retention policy to meet your internal data retention policy. For 
example:

Set the maximum age to 90 days. 

Set the maximum size to 700 GB.

After creating your first storage group, you may create another storage group for the 
remaining available space in your storage volume. For example, if your maximum size is 
700 GB for the first storage group, the remaining availabe space for the next group will be 
324 GB. See the section on Storage Groups in the ArcSight Logger Administrator’s Guide.
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Configure Indexing
The default option on Logger is No Indexing. However, ArcSight recommends using default 
indexing options for better performance.

Refer to the ArcSight Logger Administrator’s Guide for information on selecting fields for 
indexing.

Reboot Logger
After completing Logger configuration, reboot to commit changes before other resources 
can be created. See the section on System Reboot in the ArcSight Logger Administrator’s 
Guide.

Create SmartMessage Receivers
After initializing Logger, you can create a SmartMessage Receiver in Logger to listen for 
events. Make sure to use the settings mentioned below when creating the SmartMessage 
Receiver: 

Receiver Name: esm-manager-receiver 

Important: Use this exact name because Forwarding Connector expects this name.

Receiver Type: SmartMessage 

Receiver Encoding: UTF-8 

After SmartMessage receiver is configured, enable the Receiver.

For more information about setting up the Receiver, see the ArcSight Logger 
Administrator’s Guide.

Using a Secondary ArcSight Logger
ArcSight Logger in ArcSight Express All-in-One stores events for up to 90 days; beyond that 
period, old events are dropped. You may want to consider installing another Logger as your 
secondary storage appliance to extend your retention days. The storage appliance comes 
with its own Getting Started with ArcSight Logger document to help you install your 
newly-purchased storage appliance.

After you have installed the secondary ArcSight Logger, you will need to configure the 
ArcSight Forwarding Connector to send the events to this Logger. Refer to the sections, 
“Sending Events to ArcSight Logger” and “Forwarding Events to ArcSight Logger” in the 
SmartConnector Configuration Guide for ArcSight Forwarding Connector document 
available on the ArcSight Customer Support website.

You are done with Logger setup. For the next step, go to Configuring ArcSight Forwarding 
Connector.

When you reboot Logger (which reboots ArcSight Express All-in-One), the 
Storage Volume and Storage Group settings become permanent. Only certain 
settings of non-default Storage Groups can be changed. See the ArcSight 
Logger Administrator’s Guide for details on this.
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Configuring ArcSight Forwarding Connector
After you have configured Logger, you will need to configure the ArcSight Forwarding 
Connector to send events to Logger. ArcSight Forwarding Connector is pre-installed in 
ArcSight Express All-in-One. The objective of this configuration is to specify ESM Manager 
as the source of events and ArcSight Logger as the destination.

Use this sequence:

Set Up Forwarding Connector User in ESM Manager–A Forwarding Connector user 
account is entered in ESM Manager, which is the originator of events.

Set Up Forwarding Connector in ArcSight Express All-in-One–The IP address and 
receiver name are entered to match the values in the OS and in Logger, respectively.

Set Up Forwarding Connector User in ESM Manager
The first part of the setup instructs you to enter Forwarding Connector information, such as 
a Forwarding Connector user account, in ESM Manager. This section gives you the steps at 
a high level. The detailed information is found in the SmartConnector Configuration Guide 
for ArcSight Forwarding Connector.

1 Make sure ArcSight Express All-in-One has been configured properly through First Boot 
Wizard.

2 Make sure ESM Console has been installed. If you have not installed the console, see 
“Installing ArcSight Console” on page 35. You will use the console to access ESM 
Manager.

3 Refer to the SmartConnector Configuration Guide for ArcSight Forwarding Connector 
and follow the procedures to assign privileges on the ESM Source Manager.

Set Up Forwarding Connector in ArcSight Express 
All-in-One

The second part of the setup instructs you to run the Forwarding Connector setup in 
ArcSight Express All-in-One.

To set up Forwarding Connector:

1 In the appliance, go to this directory:

/opt/arcsight/connector_esm/current/bin

2 Run this command to launch the connector configuration wizard:

./arcsight connectorsetup

3 Use the following settings:

For the desgination type, select ArcSight Logger SmartMessage.

For Logger Host Name/IP, enter the host name or IP address of the 
ArcSight Express All-in-One appliance.  Use the same value you configured during 
setup on Step 15 on page 14.

For Receiver Name, keep the default name, esm-manager-receiver. This is 
the same name you were instructed to enter during Logger configuration in 
“Create SmartMessage Receivers” on page 31.
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For ArcSight Source Manager Hostname, enter the host name or IP address of the 
ArcSight Express All-in-One appliance. Use the same value you configured during 
setup on Step 15 on page 14.

For ArcSight Source Manager User Name and Password, enter the name and 
password you used for the Forwarding Connector user account in ESM Manager.

4 When you are finished, restart the Forwarding Connector with the following command:

/etc/init.d/arc_esm_connector restart

The restart enables your settings to take effect.

Refer to the topic on sending events to ArcSight Logger in the SmartConnector 
Configuration Guide for ArcSight Forwarding Connector for details. The document is 
available on the ArcSight Customer Support website.

Configuring ArcSight Threat Response Management 
(TRM)

If you want to use ArcSight TRM, you need to configure the TRM service. See Chapter 5‚ 
Using ArcSight TRM™ in ArcSight Express All-in-One‚ on page 53 for the procedures.

Important: If you are not using ArcSight TRM at this time, please run the following 
commands as root:  

sp=`/sbin/service  trm  status  postgresql’
sd=`/sbin/service  trm  status  daemontools’
if [[  $sp == DOWN*  &&  $sd == UP*  ]]; 
then
  /sbin/service  trm  stop  daemontools;  
fi

Run the commands only once. 

This is because certain TRM processes are automatically running and they generate 
messages that may fill up the logs. The above commands will prevent problems with the 
logs filling up. Subsequent reboots of the ArcSight Express All-in-One appliance will not 
require you to re-run the commands. If you decide to use ArcSight TRM in ArcSight Express 
later, then follow the procedures in Chapter 5‚ Using ArcSight TRM™ in ArcSight Express 
All-in-One‚ on page 53.

Configuring ArcSight IdentityView Express and Active 
Directory Model Import Connector

If you want to use IdentityView, you need to manually install and configure it. The 
installation files and related documents are in the following directory:

/root/IdentityViewExpress.installers

This directory includes the necessary files for IdentityView Express and the Active Directory 
Model Import Connector.

To install IdentityView: 

1 Install the ESM Console according to the instructions in Chapter 3‚ Installing ArcSight 
Console‚ on page 35, if Console is not yet installed. Note that ESM Console should be 
installed in a separate system, not in ArcSight Express All-in-One.
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2 From the ArcSight Express All-in-One appliance, copy the ARB file: 

/root/IdentityViewExpress.installers/ArcSight-SolutionPackage-IdentityViewEx
press.1.1.1.6460.arb 

to the system where you had installed ESM Console. 

3 Upload the ARB file through Console according to the instructions on installing the 
IdentityViewExpress package in the ArcSight Deployment Guide for IdentityView 
Express.

4 On the ArcSight Express All-in-One appliance, add the Active Directory Model Import 
Connector as follows:

a Open a command shell and log in as root.

b Enter the following command:

chmod +x 
/root/IdentityViewExpress.installers/ArcSight-4.7.6.5515.0-ADIdentityModelCo
nnector-Linux.bin

This converts the connector file to an executable.

c Install the Active Directory Model Import Connector according to the instructions 
found in SmartConnector Configuration Guide for Microsoft Active Directory 
Identity Model.

Next Steps
You are now ready for the next steps:

Configuring SmartConnectors

Configuring additional software components if you want to take advantage of their 
features. These include:

ArcSight TRM

ArcSight IdentityView Express

Service packs: If there are any service packs available, work with ArcSight Customer 
Support before downloading and installing any service packs. Service packs come with 
their own Upgrade Guides. Note that individual software components in 
ArcSight Express All-in-One may have their own release schedules, so coordinate with 
Arcsight Customer Support on when an upgrade in the ArcSight Express All-in-One 
appliance is appropriate.
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Installing ArcSight Console

The ArcSight Console provides a user interface for you to perform administrative tasks on 
ArcSight Express, such as fine tuning the pre-installed ArcSight Express content and 
creating/editing/deleting users. The Console should only be used for administrative 
purposes. The ArcSight Console provides a host-based interface (as opposed to the 
browser-based interface of ArcSight Web) to ArcSight Express.  This chapter explains how 
to install and configure the ArcSight Console. 

The following topics are covered in this chapter:

ArcSight Console is deployed on several perimeter machines located outside the firewall 
which protects the ArcSight Express.

Console Supported Platforms
The following operating system platforms are supported.  

Make sure that you have successfully configured ArcSight Express before 
proceeding.

“Console Supported Platforms” on page 35

“Using a PKCS#11 Token” on page 36

“Installing the Console” on page 36

“Starting the ArcSight Console” on page 43

“Reconnecting to the ArcSight Manager” on page 44

“Reconfiguring the ArcSight Console” on page 44

“Uninstalling the ArcSight Console” on page 44

Platform
Supported Operating 
System

Typical System Requirements

Windows Microsoft Windows Vista 
SP2 64-bit  

Microsoft Windows Vista 
SP2 32-bit  

Microsoft Windows XP 
Professional SP3 32-bit

x86-compatible single or multi-CPU 
system with 1-2 GB RAM
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Using a PKCS#11 Token

Starting ESM v4.0 SP2, ArcSight ESM supports the use of a PKCS#11 token, such as the 
Common Access Card (CAC), which is used for identity verification and access control. 
PKCS#11 is a public key cryptography standard which defines an API to cryptographic 
tokens. 

You can use the PKCS#11 token regardless of the mode that the client is running in - with 
clients running in FIPS 140-2 mode or with clients running in the default mode. See 
Appendix I‚ Using the PKCS#11 Token‚ on page 219 for details on using a PKCS #11 token 
with the Console.

Installing the Console

Download the ArcSight Console installer file for your platform from the ArcSight Customer 
Support download site and install the Console on your system after configuring ArcSight 
Express.

1 To install ArcSight Console, run the self-extracting archive file . Click Next in the 
Installation Process Check screen. 

2 Read the introductory text in the Introduction panel and click Next. 

3 Read the text in the Special Notice panel and click Next. 

4 Navigate to an existing folder where you want to install the Console or accept the 
default and click Next. If you specify a folder that does not exist, the folder gets 
created for you.

5 Select where you would like to create a shortcut for the Console and click Next. 

PKCS #11 token support may not be available for all ESM versions and 
ArcSight Express models.

Do not install the ArcSight Console on the ArcSight Express Appliance. See the 
section “Console Supported Platforms” on page 35 for supported platforms for 
ArcSight Console.

A Windows system was used for the sample screens. If you are installing on a 
Unix based system, you will notice a few Unix-specific screens. Path 
separators are / for Unix and \ for Windows.

On Windows Vista (64-bit): Make sure that you have administrative 
privileges to the C:\, C:\Program Files, and C:\Windows directories because 
these are protected folders and you will not be able to create files (creating a 
folder is allowed, but you need administrative privileges to create a file) under 
them without having administrative privileges. When you try to export a 
package to one of these protected folders, the Console checks the permissions 
for the parent folder, and when it tries to write the file, an exception is thrown 
if the parent folder does not have explicit write permission. As a result, the 
Console will not be able to export a resource package directly under these 
folders. 
36 ArcSight Express All-in-One Configuration Guide ArcSight Confidential



3 Installing ArcSight Console
6 View the summary in the Pre-Installation Summary screen and click Install if you are 
satisfied with the paths listed. If you want to make any changes, use the Previous 
button to do so. 

You can view the installation progress in the progress bar.

Transferring Configuration from an Existing Installation
After the Console has been installed, the wizard asks if you would like to transfer 
configuration options from an existing installation of ArcSight Console. Choose No, I do 
not want to transfer the settings to create a new, clean installation and click Next. If 
you choose Yes, I want to transfer the settings, the wizard will determine the version 
of the previous installation and may offer additional upgrade options.
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Selecting the Mode in which to Configure ArcSight 
Console

Next, you will see the following screen:

Select the Run console in default mode radio button and click Next.

Manager Connection
The ArcSight Console configuration wizard prompts you to specify the ArcSight Manager 
with which to connect.

The hostname is the ArcSight Express Appliance host name or its IP address. The Manager 
host name that you had entered in the First Boot Wizard while configuring the ArcSight 
Express Appliance and the value of the Manager Host Name that you will be entering in this 
screen should be identical. If you had entered the machine name when configuring the 
First Boot Wizard, then you must enter the machine name here too, likewise, if you had 
entered the machine’s IP address then you must enter the machine’s IP address in this 
screen too.

The FIPS 140-2 mode is not supported for ArcSight Express.

Do not change the Manager’s port number.
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Click Next. 

Select Use direct connection option and click Next. You can set up a proxy server and 
connect to the Manager using that server if you cannot connect to the Manager directly. 
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If you select the Use proxy server option, you will be prompted to enter the proxy server 
information.

Enter the Proxy Host name and click Next.

SSL Certificate used by Manager
You will see the following screen:

ArcSight Express is pre-configured with a self-signed certificate, so leave this checkbox 
unchecked. Click Next.

Authentication
The ArcSight Console configuration wizard prompts you to choose the type of client 
authentication you want to use, as shown in the following screen:  
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Select Password Based Authentication and click Next.

Web Browser
The ArcSight Console configuration wizard prompts you to specify the default web browser 
you want to use to display reports, Knowledge Base articles, and other web page content.

Specify the location of the executable for the web browser that you want to use to display 
the Knowledge Base articles and other web pages launched from the ArcSight Console. 
Click Next. 

This release of ArcSight Express supports Password Based Authentication 
only.
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User Logs and Preferences 

Select This is a single user installation (Recommended) and click Next.

You have completed configuring your ArcSight Console. Click Finish in the following 
screen. 

Click Done in the next screen.

On Mac OS X 10.5 update 8 and later:

The Mac OS update changed the password for the cacerts file in the system's 
JRE. Before you start the Console, you need to change the default password 
for the cacerts file by setting it to the following in the client.properties 
file (create the file if it does not exist) in the Console’s \current\config 
folder by adding:

ssl.truststore.password=changeme
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You have installed the ArcSight Console successfully. Please be sure to install any available 
patches for the Console. Refer to the ArcSight ESM Patch Release Notes for instructions on 
how to install a patch for the Console.

Starting the ArcSight Console

After installation and setup is complete, you can start ArcSight Console. 

To start the ArcSight Console, use the shortcuts installed or open a command window on 
the Console’s \bin directory and run:

arcsight console

Logging into the Console
To start the Console, click Login.

When you start the Console for the first time, after you click Login, you will get a dialog 
asking you whether you want to trust the Manager’s certificate. The prompt will show 
details specific to your settings (following is just an example). Click OK to trust the 
Manager’s certificate. The certificate will be permanently stored in the Console’s truststore 
and you will not see the prompt again the next time you log in.

The Manager on ArcSight Express Appliance should be up and running before 
you start the Console.
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Creating ArcSight Express Users
The next step is to create users. ArcSight Express comes configured with a custom user 
group called ArcSight Express. Add users to this group with ArcSight Web privileges. 

In the Navigator panel, go to Users > Shared > Custom User Groups. ArcSight Express 
comes configured with a custom user group called ArcSight Express. Add users to this 
group with ArcSight Web privileges. 

1 In the Navigator panel, go to Users > Shared > Custom User Groups.

2 Right click on ArcSight Express and select New User.

For each user you add, provide a User ID and Password, and set the User Type to 
Web User and click OK. If the Navigator panel is not visible, you can open it by 
clicking Window->Navigator Panel. Then right click on ArcSight Express and select 
New User.

3 For each user you add, provide a User ID and Password, and set the User Type to 
Web User and click OK.

Reconnecting to the ArcSight Manager
If the ArcSight Console loses the connection to the ArcSight Manager (for example, 
because the Manager was restarted), a dialog box appears in the ArcSight Console stating 
that your connection to the ArcSight Manager has been lost. Click Retry to re-establish a 
connection to the ArcSight Manager or click Start Over. 

Connections to the ArcSight Manager cannot be re-established while the ArcSight Manager 
is restarting or if the Manager refuses the connection. In addition, you may see connection 
exceptions during the Retry process while the connection is lost or ArcSight Manager is 
restarting.

Reconfiguring the ArcSight Console
You can reconfigure ArcSight Console at any time by running the following command within 
a command window from the Console’s \bin directory:

arcsight consolesetup

and follow the prompts.

Uninstalling the ArcSight Console
Before uninstalling the ArcSight Console, exit the current session.

To uninstall on Windows, run the Start->All Programs (Programs in the case of 
Windows XP)->ArcSight Console ->Uninstall ArcSight Console 5.0 program. If a 
shortcut to the Console was not installed on the Start menu, locate the Console’s 
\UninstallerData folder and run:

Uninstall_ArcSight_Console.exe
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Using SmartConnectors with 
ArcSight Express All-in-One

This chapter covers the following topics:

SmartConnectors Overview
SmartConnectors process raw data generated by various vendor devices throughout an 
enterprise. Devices are hardware and software products such as routers, anti-virus 
products, firewalls, intrusion detection systems (IDS), VPN systems, anti-DoS appliances, 
operating system logs, and other sources that detect and report security or audit 
information.

ArcSight SmartConnectors collect a vast amount of varying, heterogeneous information. 
Due to this variety of information, SmartConnectors format each event into a consistent, 
normalized ArcSight events, letting you find, sort, compare, and analyze all events using 
the same event fields. The “normalized” events are then sent to the ArcSight Manager and 
are stored in the ArcSight Database or forwarded to ArcSight Logger if you choose to 
enable forwarding events.

You have the option to use up to eight SmartConnector(s) locally (four per container) on 
Logger.

Importing the Manager’s Certificate
You will be required to import the Manager’s certificate manually. You can use either of the 
two methods to import the certificate:

Use the keytoolgui tool. See the ArcSight ESM Administrator’s Guide for details on 
importing the Manager’s certificate using the keytoolgui,

Or

Import the Manager’s certificate using the Connector Manager software.

Using keytoolgui to Import Manager’s Certificate
You will need to export the Manager’s certificate from ArcSight Express All-in-One before 
you can import it on the Smart Connector.

“SmartConnectors Overview” on page 45

“Importing the Manager’s Certificate” on page 45

“Adding the Certificate File for Onboard Connectors” on page 51
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Exporting the Manager’s Certificate

To export the Manager’s certificate:

1 Open a shell/command prompt window on the ArcSight Express All-in-One appliance.

2 As the arcsight user, run the following command from the ArcSight ESM Manager’s 
/opt/arcsight/manager/bin directory:

./arcsight keytoolgui

The keytoolgui interface opens.

3 Select File->Open KeyStore from the menu and navigate to the Manager’s 
truststore (cacerts) located in /opt/arcsight/manager/jre/lib/security/ 
directory.

4 Enter the keystore password. The default password is changeit.
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5 Right-click the Manager’s certificate as shown below and select Export.

6 Accept the default settings in the following dialog and click OK.

7 Navigate to the location where you want to export the certificate and make sure to 
enter cacerts in the File Name text box when naming the certificate: 

8 Click Export.
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The following prompt is displayed if the certificate is exported successfully.

9 Click OK and exit the keytoolgui.

10 Transfer (or scp) this exported certificate file from the ArcSight Express All-in-One 
appliance to the Smart Connector directory where you will be importing it into the 
SmartConnector.

Importing the Manager’s Certificate into the SmartConnector’s 
Truststore

Import the certificate you exported above into the Connector’s truststore. 

To do so:

1 Open a shell/command prompt window on the ArcSight Express All-in-One appliance.

2 Run the following command from the Connector’s 
/opt/arcsight/connector/current/bin directory while logged in as user 
“arcsight”:

./arcsight agent keytoolgui

The keytoolgui interface opens.
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3 Select File->Open KeyStore from the menu and navigate to the Connector’s 
truststore (cacerts) located in 
/opt/arcsight/connector/current/jre/lib/security/ directory.

4 Enter the password. The default password is changeit

5 Select Tools->Import Trusted Certificate.
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6 Navigate to the Manager’s certificate, select it, and click Import.

7 At the following prompt, click OK to see the certificate details.

The Certificate Details dialog is displayed.

8 Click OK on the Certificate Details dialog to accept the certificate.

9 Click Yes in the following dialog.

10 Enter an alias for the certificate and click OK.

The following message is displayed if the import is successful:

11 Click OK.
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12 Select File->Save KeyStore to save the certificate in the Connector’s truststore and 
exit the keytoolgui interface.

Import the Manager’s certificate using Connector 
Manager

1 Open a web browser on your desktop and connect to Logger by typing in the URL to 
ArcSight Express All-in-One:

https://<ArcSight Express IP address>

2 To upload the CA Certs file to Logger, go to Configuration->Advanced 
Operations->CA Certs->CA Certs Repositories tab, and click Upload. 

3 Navigate to the cacerts file in the ArcSight Express Manager’s 
/opt/arcsight/manager/jre/lib/security/, select the file, and click Submit 
to start the upload process.

4 Click Apply CA Certs tab and select the container by checking the checkbox to the 
right of it.

5 Click Update to apply this CA Certs file to the container.

6 Continue to configure the connectors and register them with the Manager whose 
certificate you just imported. 

Adding the Certificate File for Onboard Connectors
This information applies to ArcSight Express All-in-One onboard connectors. You will need 
to store CA Certs files into a repository, then add the files on a container.

For the related procedures, refer to the ArcSight Connector Appliance Installation and 
Administrator’s Guide. Refer to the topics on managing CA Certs repositories and managing 
certificates on a container.
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Chapter 5

Using ArcSight TRM™ in 
ArcSight Express All-in-One

This chapter is written for users who want to take advantage of ArcSight TRM™ 
functionality that is available with ArcSight Express All-in-One. This chapter covers the 
following topics:

Adding and Starting the TRM Service
The following commands help you add and start the TRM service. These are the 
prerequisite steps before configuring ArcSight TRM in ArcSight Express All-in-One.

As root, enter the following commands:

service trm add

service trm start

You can now proceed with “Configuring ArcSight TRM” on page 53.

Configuring ArcSight TRM
This topic describes procedures to configure ArcSight TRM, which you will perform in the 
following sequence:

1 Enter Network Settings using the NSP interface. 

2 Add the ArcSight Threat Response Manager (TRM) SmartConnector using the Logger 
interface. 

3 Define ESM Rules using ESM Console.

“Adding and Starting the TRM Service” on page 53

“Configuring ArcSight TRM” on page 53

“Restoring TRM Data from Backups” on page 56

“ArcSight TRM Commands” on page 57
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Enter Network Settings
You need to enter the IP address and gateway that match the settings entered during OS 
configuration. You will do this in the NSP interface (TRM is one of the function tabs of the 
NSP interface).

To enter network settings:

1 Access the NSP interface by entering the following URL in your browser:

https://<ArcSight Express IP address>:1443

2 Under System, select Settings > Admin > Network.

3 Use the following settings:

For Default Gateway, enter the address of your production environment’s 
gateway.

For Eth0, make sure it matches the address you entered during OS setup at Step 
14 on page 14.

For Hostname, use the hostname you entered during OS setup at Step 15 on 
page 14.

For Allow System Ping, click Yes.

To save changes, click Update Settings.

4 Verify that the information in the other System Setting tabs (for example, DNS, SMTP, 
Static Routes, and so forth) are correct. These will be used by the appliance.

For more information about Threat Response Manager and its settings, refer to the Threat 
Response Manager chapter of the ArcSight NSP Installation and Administration Guide.

As directed in the following procedure, use the same network settings in TRM 
as those in your OS. If they don’t match, the next time you reboot the 
ArcSight Express All-in-One appliance, TRM network settings will overwrite the 
appliance’s OS network settings. As a result, the appliance will not start up 
successfully. Please follow the procedures exactly as shown.
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Add the ArcSight Threat Response Manager (TRM) 
SmartConnector

ArcSight TRM uses the Threat Response Manager (TRM) SmartConnector to integrate with 
ArcSight ESM. In the following procedures, you will use the Logger interface to add the 
TRM SmartConnector. 

To add Threat Response Manager SmartConnector to Container 1

1 Access the Logger interface by entering the following URL in your browser:

https://<ArcSight Express IP address>

2 Follow the instructions to add a connector in the ArcSight Logger Administrator’s 
Guide, chapter on “Managing Connectors on Connector Appliance.” Use the following 
settings:

Add ArcSight Threat Response Manager connector to Container 1.

For Destination, use <ArcSight Express IP address>:1443, which is TRM’s 
port number.

Adding TRM SmartConnector to Container 2
For the purposes of ArcSight Express All-in-One, Arcsight recommends that you add TRM 
SmartConnector to Container 1. However, if you have reached the maximum limit for 
Container 1 and you need to add another TRM SmartConnector, you may add it to 
Container 2.

1 Follow the same basic instructions in To add Threat Response Manager 
SmartConnector to Container 1.

2 As root, use the following command to create the endorsed directory:

mkdir -p /opt/arcsight/connector_2/current/jre/lib/endorsed/

3 Copy the saaj.jar file, which is required by TRM, to the endorsed directory: 

cp -pv /opt/arcsight/trm/local/tomcat/webapps/nwsapi/WEB-INF/lib/saaj.jar \
/opt/arcsight/connector_2/current/jre/lib/endorsed/saaj.jar

4 Restart the connector:

/sbin/service  arc_appliance_connector_2 restart

Define ESM Rules
After you have added TRM SmartConnector, you are ready to define ESM rules that trigger 
TRM actions. Refer to the SmartConnector Configuration Guide for ArcSight Threat 
Response Manager for details.

You will need ESM Console for rule definition tasks. If you have not yet installed ESM 
Console, refer to “Installing ArcSight Console” on page 35 for the procedures. Noite that 
you install Console in a separate system and not in ArcSight Express All-in-One.
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Restoring TRM Data from Backups
If you are restoring TRM data from backups in the ArcSight Express All-in-One appliance, 
you will perform the steps on the NSP user interface, then continue with the process by 
entering shell commands.

To restore TRM data from backups:

1 Access the NSP UI by entering the following URL in your browser:

https://<ArcSight Express IP address>:1443

2 Select Admin > System > Backup & Restore > Restore From Backup.

3 Browse to and select your previously-created backup file, then click Upload Backup 
to upload.

A message states that the backup is uploaded and verified.

Do not click Verify and Begin Restore button. Restoring the backup in 
this manner will not work and will cause system problems.

4 Close the browser window or navigate to another TRM page to avoid problems with 
the Verify and Begin Restore button.

5 As root, enter the following shell commands to restore the TRM backup file and 
restart the TRM service:

service trm stop
service trm start postgresql
file=`find /opt/backups/restore/*/opt/backups/ \
  -type f -not -name '*.md5' \
  -printf "%CY%Cm%Cd-%CT %p\n" \
  | sort | cut -d' ' -f2 | tail -1`
echo "Restoring database from backup using file: $file"
/opt/arcsight/trm/local/pgsql/bin/dropdb \
  --port 11976 --username cprpgsql rwdb
cat $file | /opt/arcsight/trm/local/pgsql/bin/psql \
  --port 11976 --username cprpgsql -d template1
service trm start
exit

6 Verify the network settings that you have restored from backup, making sure they 
match the settings of the ArcSight Express All-in-One operating system. On the NSP 
UI, under System, select Settings > Admin > Network and verify the following.

Make sure Eth0 matches the address you entered during OS setup at Step 14 on 
page 14.

Make sure Hostname matches the hostname you entered during OS setup at 
Step 15 on page 14.

7 Verify that the information in the other System Setting tabs (for example, DNS, SMTP, 
Static Routes, and so forth) are correct. These will be used by the appliance.

The network settings in TRM must match those in your OS. If they 
don’t match, the next time you reboot the appliance, TRM network 
settings will overwrite the OS network settings. As a result, the 
appliance will not start up successfully.
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ArcSight TRM Commands
This topic describes some useful commands to use the TRM service in ArcSight Express 
All-in-One.

To use TRM, run the following commands in a root shell:

For more information about TRM functionality, refer to the TRM chapter of the 
ArcSight NSP Installation and Administration Guide.

Command Description

/sbin/service trm add This command configures TRM to use the same 
license as other applications, and configures 
the system to start or stop TRM processes 
during bootup or shutdown. The command 
prints a running summary of status. After this 
command succeeds, any reboot will restart 
TRM, so a user might only need to manually 
add and start TRM one time.

/sbin/service trm start This command starts all TRM processes 
running. The command prints a summary of 
TRM startup status. TRM startup typically 
completes in a few seconds.

/sbin/service trm stop This command stops all TRM processes that 
are running. The command displays a 
summary of TRM shutdown status. TRM 
shutdown typically completes in a few seconds.

/sbin/service trm help This command provides information on TRM 
service actions such as list, restart, status, 
and stop.
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Appendix A

Troubleshooting

The following information may help solve problems that might occur during installation, 
setup, and use of ArcSight Express All-in-One. In some cases, the solution can be found 
here or in other documentation, but ArcSight Customer Support is available if you need it. 

This chapter covers the following topics:

If you intend to have ArcSight Customer Support guide you through a diagnostic process, 
please prepare to provide specific symptoms and configuration information.

“Location of Log Files for Components” on page 60

“Customizing ESM Components Further” on page 61

“Replacing the License” on page 62

“Disabling Unused Network Interfaces” on page 62

“Fatal Error when Running First Boot Wizard” on page 62

“Manager Service Failed when Starting” on page 64

““Failed” Status while Configuring or Starting a Component” on page 64

“Error When Running SmartConnector Setup Wizard” on page 66

“Changing Network Settings After Configuring Them in First Boot Wizard” on page 66
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Location of Log Files for Components
The log file for each component can be found in the following locations:

First Boot Wizard:

/opt/arcsight/manager/logs/firstboot.log

/opt/arcsight/manager/logs/default/managerwizard.log

/opt/arcsight/manager/logs/default/serverwizard.log

ArcSight Database:

/opt/arcsight/db/logs

ArcSight Manager:

/opt/arcsight/manager/logs/default

ArcSight Web:

/opt/arcsight/web/logs/default

ArcSight Forwarding Connector:

/opt/arcsight/connector_esm/current/logs

ArcSight Logger:

/opt/arcsight/logger/logs

Container 1 for SmartConnectors:

/opt/arcsight/connector_1/current/logs

Container 2 for SmartConnectors:

/opt/arcsight/connector_2/current/logs

ArcSight Logger onboard connector:

/opt/arcsight/connector/current/logs

ArcSight TRM:  

/opt/arcsight/trm/local/apache/logs/access_log*

/opt/arcsight/trm/local/apache/logs/error_log*

/opt/arcsight/trm/local/pgsql/data/serverlog*

/opt/arcsight/trm/local/tomcat/logs/*

/var/log/messages

/var/log/secure

/var/log/dmesg

/opt/updates/*.log

/opt/arcsight/trm/ENIRA/data/temp/*

/opt/arcsight/trm/ENIRA/data/debug/*

/opt/arcsight/trm/ENIRA/data/insp_log*
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/opt/arcsight/trm/ENIRA/data/exceptions.log* 

On the machine where you install the Console (Console is not installed in the 
ArcSight Express All-in-One appliance):

ArcSight Console:

<ARCSIGHT_HOME>\current\logs

Customizing ESM Components Further
First Boot Wizard configures the software components on ArcSight Express All-in-One 
(ArcSight Database, ArcSight Manager, and ArcSight Web) for you. But in the event that 
you would like to customize a component further, you can follow these instructions to start 
the setup program for the component:

ArcSight Database
While logged in as the “root” user, run the following command from 
/opt/arcsight/db/bin directory:

./arcsight database pc

ArcSight Manager
While logged in as user “arcsight”, run the following command from 
/opt/arcsight/manager/bin directory:

./arcsight managersetup

ArcSight Web
While logged in as user “arcsight”, run the following command from 
/opt/arcsight/web/bin directory:

./arcsight websetup

Follow the prompts on the wizard screens. To get more information on an individual screen 
for any of the components listed above, see the ArcSight ESM Installation and 
Configuration Guide available on the ArcSight Customer Support download site.

ArcSight Forwarding Connector
While logged in as user “root”, run the setup program from the 
/opt/arcsight/connector_esm/current/bin directory:

./arcsight connectorsetup

and follow the prompts on the screen. Refer to the SmartConnector Configuration Guide for 
ArcSight Forwarding Connector document available on the ArcSight Customer Support 
download site.
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Replacing the License
You may need to replace your ArcSight Express All-in-One license (arcsight.lic) when 
it expires or you are moving from a demo to a user license. Contact ArcSight Customer 
support for the required license. Follow these instructions:

1 As root, run the following commands:

cd /opt/arcsight/manager/bin

./arcsight deploylicense

This launches the License Deployer Wizard. 

2 Follow the steps in the wizard to upload the new license file.

3 Reboot the appliance to apply the new license.

Disabling Unused Network Interfaces
 To avoid networking problems, ArcSight recommends that you disable the unused three 
interfaces (NICs) on the ArcSight Express All-in-One appliance. The interfaces are eth1, 
eth2, and eth3. This was done in First Boot Wizard on Step 16 on page 16. If this was not 
done at that time, and you want to disable unused NICs after you have run the wizard, 
refer to the following instructions.

As root, run the following script:

for i in  1  2  3
do

sed -i /etc/sysconfig/network-scripts/ifcfg-eth$i \
  -e 's/ONBOOT=yes/ONBOOT=no/'
/sbin/ifconfig eth$i down

done

Fatal Error when Running First Boot Wizard
If you encounter a fatal error such as a the one shown below while running First Boot 
Wizard, the wizard will display an error message and then exit.
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To resolve this issue, try the following steps:

1 Check the /opt/arcsight/manager/logs/firstboot.log file to figure out 
where the error occured.

2 Verify that the IP address for the appliance has been configured correctly (eth0 has 
been configured correctly) and is available (not already in use for some other system 
on your network).

3 Make sure that the tnslistener and Oracle services are started.

To check the status of the TNS listener, run this command from the 
/opt/arcsight/db/bin directory:

% ./arcdbutil lsnrctl status 

To check whether Oracle services have been started, run the following:

% ./arcdbutil sql 

Enter user-name: / as sysdba

Enter password:

Enter arcsight for the password. You will get the sqlplus prompt only if the Oracle 
services are running.

4 Restart First Boot Wizard by running the following command from the 
/opt/arcsight/manager/bin directory when logged in as root:

./arcsight appliancefirstbootsetup

First Boot Wizard can only be re-run until the point that the Manager has not been 
configured.

If the steps above do not solve the issue, you will be required to revert ArcSight Express 
All-in-One to its factory settings. For instructions on how to do this, see Appendix C‚ 
Restoring Factory Settings‚ on page 79.

To run the commands at this step, you must be logged in as the Oracle user. 
If you are not the Oracle user, first run the command to switch user:

# su - oracle
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Manager Service Failed when Starting
If the Manager service fails to start giving you the following error:

You will need to start the Manager service manually. See Step 3 on page 65 for 
information on how to start the Manager service manually. 

You will also be required to configure the Forwarding Connector and ArcSight Web 
manually. See “Failed” Status while Configuring or Starting a Component section for 
details on how to run Forwarding Connector and ArcSight Web setups manually.

You will be required to run the tablespace expansion manually. See Step 2 on page 65 
for details on how to do this.

In the event that any of the above steps do not work, we recommend that you revert 
ArcSight Express All-in-One to its factory settings. For instructions on how to do this, see 
Appendix C‚ Restoring Factory Settings‚ on page 79.

“Failed” Status while Configuring or Starting a 
Component

If you cancel out of First Boot Wizard before you reach the screen below, you can re-run 
the wizard:

However, if you click Next in the screen above and the configuration begins, and if any step 
fails or you cancel out of the wizard, you will be required to run the corresponding 
component setup program and configure the component manually.

If you see a “Failed” status for any component, such as the follows, you will be required to 
configure the component manually. To find out the reason for the failure, look at the log for 
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the component. See “Location of Log Files for Components” on page 60 for the location of 
the logs. 

Here are the steps to configure a component manually:

1 To configure the partition management notification e-mails for the ArcSight Database 
software component, run the following command from /opt/arcsight/db/bin 
directory on ArcSight Express while logged in as root:

./arcsight database pc

and follow the prompts on the screen. Refer to the ArcSight ESM Installation and 
Configuration Guide for information on each screen. You can download this guide from 
the ArcSight Customer Support download site.

2 To expand the tablespaces manually, run the following command from 
/opt/arcsight/db/bin directory on ArcSight Express while logged in as root:

./arcsight database xts

3 To start the Manager service manually, run the following command from 
/etc/init.d directory as root on ArcSight Express:

./arcsight_manager start

and follow the prompts on the screen. Refer to the ArcSight ESM Installation and 
Configuration Guide for information on each screen. 

4 To configure the Forwarding Connector manually, run the setup program from the 
/opt/arcsight/connector_esm/current/bin directory on ArcSight Express as 
root: 

./arcsight connectorsetup

and follow the prompts on the screen. Refer to the SmartConnector Configuration 
Guide for ArcSight Forwarding Connector document available on the ArcSight 
Customer Support download site.

5 To configure ArcSight Web manually, run the following command from the 
/opt/arcsight/web/bin directory on ArcSight Express as arcsight:

./arcsight websetup
ArcSight Confidential ArcSight Express All-in-One Configuration Guide 65



A Troubleshooting
and follow the prompts on the screen. Refer to the ArcSight ESM Installation and 
Configuration Guide for information on each screen. 

6 To start the Web server service manually, run the following command from 
/etc/init.d directory as root on ArcSight Express:

./arcsight_web start

7 To manually start a Forwarding Connector service, run the following command from 
/etc/init.d directory on ArcSight Express as root:

./arc_esm_connector start

In the event that any of the above steps do not work, we recommend that you revert your 
ArcSight Express to its factory settings. For instructions on how to do this, see Appendix C‚ 
Restoring Factory Settings‚ on page 79.

Error When Running SmartConnector Setup Wizard
If you are starting the SmartConnector setup wizard, you may encounter this error:

This is because the wizard is used only for single-SmartConnector setup. Most likely, you 
have multiple SmartConnectors in the same container.

If you get this error, use the Logger UI’s Configuration > Manage Connectors interface 
to edit SmartConnectors.

Changing Network Settings After Configuring Them in 
First Boot Wizard

ArcSight Express All-in-One is identified in the network either by IP address or by host 
name. This was set when you boot the ArcSight Express All-in-One appliance for the first 
time and configured the OS using First Boot Wizard. After First Boot Wizard has run 
successfully, you will not be allowed to run the wizard again. 

In case you want to change the IP address or host name of the appliance after you have 
successfully completed configuration through First Boot Wizard, refer to one of the 
following topics:

“Changing the IP Address After Configuring It in First Boot Wizard” on page 67

“Changing the Host Name After Configuring It in First Boot Wizard” on page 69
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Changing the IP Address After Configuring It in First Boot 
Wizard

In case you want to change the IP address of the appliance after running First Boot Wizard 
successfully, follow these steps:

1 Stop all ESM related services:

a To stop the Manager service, run the following command from /etc/init.d 
directory as root:

./arcsight_manager stop

b To stop the Web service, run the following command from /etc/init.d 
directory as root:

./arcsight_web stop

c To stop the Forwarding Connector service, run the following command from 
/etc/init.d directory as root:

/opt/local/monit/bin/monit stop connector_esm

2 Stop the TNS Listener by running the following command from 
/opt/arcsight/db/bin directory:

./arcdbutil listener stop

3 Change the IP address of the appliance in the /etc/sysconfig/network-
scripts/ifcfg-eth0 file.

4 Change the IP address in the 
/home/oracle/OraHome10g/network/admin/sqlnet.ora file.

5 If you are running TRM, enter the new IP address in TRM. See “Enter Network 
Settings” on page 54.  

6 Reboot the ArcSight Express All-in-One appliance.

If you had entered an IP address when prompted for a Manager Host Name in First 
Boot Wizard, then you will be required to do the following additional steps:

7 As root, stop the Manager and Web services again. These services would have started 
upon reboot.

8 Run the following to start the setup program for the Manager from 
/opt/arcsight/manager/bin directory:

./arcsight managersetup

This will open the Manager’s setup wizard. 

a Enter the new IP address that you set for your appliance in Step 4 above in the 
Manager Host Name field when prompted by the wizard.

Please note:

• Run Manager and Web setup commands as arcsight.

• Run all other commands as root. 

• Start and stop all services as root.
ArcSight Confidential ArcSight Express All-in-One Configuration Guide 67



A Troubleshooting
b Make sure to select the self-signed keypair option when prompted by the wizard 
and enter the required information to generate the self-signed certificate 
containing the new IP address.

9 Start the Manager service by running the following command from the /etc/init.d 
directory as root:

./arcsight_manager start

10 Import the Manager’s newly generated self-signed certificate on the webserver using 
the keytoolgui tool. See “Using keytoolgui to Import Manager’s Certificate” on 
page 45.

11 While logged in as arcsight, run the following to start the setup program for the Web 
from the /opt/arcsight/web/bin directory:

./arcsight websetup

a Enter the new IP address in Webserver Host Name field when prompted. 

b Make sure to select the self-signed keypair option when prompted by the wizard 
and enter the required information to generate the self-signed certificate 
containing the new IP address.

12 If you chose to set up Logger and Forwarding Connector when configuring ArcSight 
Express using the First Boot Wizard, stop the Forwarding Connector service by running 
the following command as root:

/opt/local/monit/bin/monit stop connector_esm

13 Import the Manager’s certificate on the connector using keytoolgui. See ArcSight 
ESM Administrator’s Guide available on the ArcSight Customer Support download site 
for details on how to do this.

14 Run the setup program for the connector from the 
/opt/arcsight/connector_esm/current/bin directory:

./arcsight connectorsetup

and enter the new IP address for the appliance in the Host Name field when 
prompted.

15 Restart the Connector service by running the following from the /etc/init.d 
directory as root:

./arc_esm_connector start

16 Import the Manager’s certificate on all clients (Console and connectors) that will be 
accessing the Manager. You can do so using the keytoolgui. See ArcSight ESM 
Administrator’s Guide available on the ArcSight Customer Support download site for 
details on how to do this. 

17 Test to make sure that the clients can connect to the Manager.
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Changing the Host Name After Configuring It in First Boot 
Wizard

In case you want to change the host name of ArcSight Express after running First Boot 
Wizard successfully, follow these steps:

1 Stop all ESM related services:

a To stop the Manager service, run the following command from /etc/init.d 
directory as user root:

./arcsight_manager stop

b To stop the Web service, run the following command from the /etc/init.d 
directory as user root:

./arcsight_web stop

c To stop the Forwarding Connector service, run the following command from the 
/etc/init.d directory as user root:

./arc_logger_connector stop

2 Stop the TNS Listener by running the following command from the 
/opt/arcsight/db/bin directory:

./arcdbutil listener stop

3 Change the host name of the appliance by editing it in the 
/etc/sysconfig/network file.

4 Edit the /etc/hosts file to reflect the new host name of ArcSight Express.

5 Run the following from the shell prompt to change the hostname on the appliance:

hostname <new_hostname>

6 Run the following from a shell prompt for your changes to take effect:

service network restart

7 Change the host name in the 
/home/oracle/OraHome10g/network/admin/listener.ora file. 

8 Change the host name in the 
/home/oracle/OraHome10g/network/admin/tnsnames.ora file.

9 Change the host name in the 
/home/oracle/OraHome10g/network/admin/sqlnet.ora file.

10 Start the TNS Listener by running the following command from 
/opt/arcsight/db/bin directory:

arcdbutil listener start

Please note:

• Run Manager and Web setup commands as arcsight.

• Run all other commands as root. 

• Start and stop all services as root.
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11 Start the Partition Configuration wizard by running the following command from 
/opt/arcsight/db/bin directory:

./arcsight database pc

and enter the new host name in the Database Host Name field when prompted.

12 If you are running TRM, enter the new host name in TRM. See “Enter Network 
Settings” on page 54.  

If you had entered an IP address in the Manager Host Name field when configuring 
ArcSight Express you will also need to do the following steps:

13 Start the Manager by running the following command from the /etc/init.d 
directory as root:

./arcsight_manager start

14 Start the Web by running the following command from the /etc/init.d directory as 
root:

./arcsight_web start

If you had entered a host name when prompted for a Manager Host Name in the First Boot 
Wizard, then you will be required to do the following in addition to the steps mentioned 
above:

15 Stop the Manager.

16 Run the Manager’s setup program from the /opt/arcsight/manager/bin 
directory as arcsight:

./arcsight managersetup

a Enter the new host name that you set for your appliance in the Manager Host 
Name field when prompted by the wizard.

b Make sure to select the self-signed keypair option when prompted by the wizard 
and enter the required information to generate the self-signed certificate 
containing the new host name.

17 Start the Manager service by running the following command from the /etc/init.d 
directory as user root:

./arcsight_manager start

18 Import the Manager’s newly generated self-signed certificate on the Webserver using 
the keytoolgui tool. See ArcSight ESM Administrator’s Guide available on the 
ArcSight Customer Support download site for details on how to do this.

19 While logged in as arcsight, run the following to start the setup program for the Web 
from the /opt/arcsight/web/bin directory:

./arcsight websetup

a Enter the new host name in the Manager Host Name and the Webserver Host 
Name fields when prompted. 

20 If you had chosen to set up Logger and Forwarding Connector when configuring your 
appliance using the First Boot Wizard, stop the Forwarding Connector service by 
running the following command from the /etc/init.d directory as root:

/opt/local/monit/bin/monit stop connector_esm
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21 Import the Manager’s certificate on the connector using keytoolgui. See ArcSight 
ESM Administrator’s Guide available on the ArcSight Customer Support download site 
for details on how to do this.

22 While logged in as root, run the setup program for the connector from the 
/opt/arcsight/connector_esm/bin directory:

./arcsight connectorsetup

and enter the new host name for the appliance in the Host Name field when 
prompted.

23 Restart the Connector service by running the following from the /etc/init.d 
directory as root:

./arc_esm_connector start

24 Import the Manager’s certificate on all clients (Console and connectors) that will be 
accessing the Manager. You can do so using the keytoolgui. See ArcSight ESM 
Administrator’s Guide available on the ArcSight Customer Support download site for 
details on how to do this. 

25 Test to make sure that the clients can connect to the Manager.
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Default Settings for Components

This appendix gives you the default settings for each software component in 
ArcSight Express All-in-One. It covers the default settings for the following:

You can always customize any component by running its setup program. Refer to Appendix 
A‚ Troubleshooting‚ on page 59 for information on running the setup program for a 
component.

“General” on page 74

“ArcSight Database” on page 74

“ArcSight ESM Manager” on page 76

“About ArcSight Web” on page 76

“ArcSight Forwarding Connector” on page 77

“ArcSight Logger” on page 77
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The following tables list the default settings for each component.

General

ArcSight Database
ArcSight Express comes pre-installed with Oracle 10.2.0.4. An Oracle instance has already 
been created for you. The following are some of the default values that have been pre-
configured in ArcSight Database for you:

Setting  Default Value

default password for Java keystore changeit

Setting  Default Value

ArcSight Database Home  /opt/arcsight/db

Oracle Home  /home/oracle/OraHome10g

Location of Oracle data files  /opt/data

CPU Information Oracle has the January 2009 CPU applied

Number of data files 16 data files and 32 index files

Data file name

ARC_SYSTEM_DATA

ARC_SYSTEM_INDEX

ARC_EVENT_DATA

ARC_EVENT_INDEX

ARC_UNDO

ARC_TEMP

Data file Size 

5 GB (1 file x 5 GB)

5 GB (1 file x 5 GB)

400 GB (25 files * 16 GB)

800 GB (50 files * 16 GB)

96 GB (12 files * 8GB)

48 GB (6 files * 8GB)

Language in which default system content 
resources will be installed

English

Partition Retention Method Space Based Retention

Target free space % 15%

Partition Management runtimes Runs 4 times in a 24 hour period. The 
default timings are 02:00, 07:00, 13:00, 
20:00.

E-mail notification level Warning

Location of Control Files /home/oracle/OraHome10g/oradata/arc
sight

Database Host name Host name or IP address of your ArcSight 
Express appliance

Database port number  1521

Database instance name arcsight
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About Data Retention on ArcSight Express All-in-One
ArcSight Express All-in-One uses the Space Based Retention method to maintain online 
data. Your data is retained based on the target free space which is the amount 
(percentage) of free space available in your database. The target free space is set to 15% 
by default. You can change this percentage by running the ./arcsight database pc 
command from the /opt/arcsight/db/bin directory and entering the desired 
percentage when prompted.

The Partition Manager (a component of the ArcSight ESM Manager that manages the life-
cycle of event data partitions from creation to elimination) is scheduled to run once every 6 
hours. When the Partition Manager runs, it calculates the free space in the database. If you 
get sudden spikes of events that fill up the database before the next 6-hourly scheduled 
run of the Partition Manager, you will get alerts in the Console and via e-mail. You can 
either manually launch Partition Manager to free up space immediately or just wait for the 
next scheduled Partition Manager run to do so. (In the latter case, events would continue 
to be cached on the connectors.) As soon as it detects that the free space available is less 
than the target free space, it drops the oldest retained partition and continues to drop the 
next oldest partition until the available free space reaches the target free space percent. At 
a minimum the current partition plus the two most recent partitions are retained even if the 
amount of free space in the database falls below the target free space. For example, if 
today is Wednesday, the Partition Manager makes sure to at least retain partitions from 
Monday and Tuesday even though that might mean leaving less than the target free space 
in the database. Audit events are generated every time a partition is dropped.

For long term data storage beyond what the disk space on ArcSight Express All-in-One 
allows, forward the events to ArcSight Logger.

Database OS user name  oracle

Database user name 
(This account will be used by ArcSight 
ESM Manager to connect to ArcSight 
Database)

 arcsight

Database Template Size  Large

Database Character set  UTF-8

Allowed TNS Clients  localhost

Auto Archive Redo logs  No

Initialize Tablespaces, Schema, and 
Resources

 Yes

Database OS username  oracle

System User name  systemuser

Minimum Partition Retention Period  2 days, by default.

To increase this period, add the following 
property in the 
/opt/arcsight/manager/config/server
.properties file:

sbr.extend.min.retention.period= 

Setting  Default Value
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ArcSight ESM Manager

The following are some of the default values that have been pre-configured in ArcSight 
ESM Manager for you:

About ArcSight Web
The following are some of the default values that have been pre-configured in ArcSight 
Web for you:

ArcSight ESM Manager uses a self-signed certificate, which is generated for 
you when you configure the appliance using the First Boot Wizard. When you 
log into the Console for the very first time you will be prompted to accept the 
Manager’s certificate. You can either click Yes in that dialog or optionally 
import the Manager’s certificate manually at a later time.

Setting Default Value

Location of Manager  /opt/arcsight/manager

Manager host name Host name or IP address of the ArcSight 
Express appliance

Manager Port  8443

Manager license file  Please obtain from ArcSight Customer 
Support

Packages installed  ArcSight Express, ArcSight Administration

Java Heap Memory  2048 MB

Authentication Type Password Based

Type of certificate used  self-signed

Default password for keystore password

Default password for truststore changeit

E-mail Notification  Internal SMTP server. If you want to use 
an External SMTP server, run the following 
command from the 
/opt/arcsight/manager/bin directory 
and set up the external SMTP server when 
prompted:

./arcsight managersetup

Sensor Asset Auto Creation  Enabled

Packages/default content installed Appliance-related content

Manager installed as service  Yes  
(name of service is arcsight_manager)

Setting Default Value

Location of ArcSight Web  /opt/arcsight/web

ArcSight Web host name Host name or IP address of the 
ArcSight Express All-in-One appliance
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ArcSight Forwarding Connector
The Forwarding Connector receives the events from the Manager and forwards the events 
to the ArcSight Logger using the SmartReceiver. The following are some of the default 
values that have been pre-configured in ArcSight Web for you:

ArcSight Logger
The ArcSight Express All-in-One includes the ArcSight Logger for connector management 
with two containers.

ArcSight Web port  9443

Java Heap Size 512 MB

Authentication Type Password Based

Default password for keystore password

Default password for truststore changeit

ArcSight Web installed as service  Yes 
(name of service is arcsight_web)

Setting Default Value

Location of ArcSight Forwarding Connector /opt/arcsight/connector_esm

ArcSight Forwarding Connector installed 
as service

 Yes

Name of the Forwarding Connector 
Service

arc_logger_connector

Setting Default Value

Location of ArcSight Logger /opt/arcsight/logger

ArcSight Logger host name IP address of the ArcSight Express 
appliance

ArcSight Logger Port  443

Container 1 for SmartConnectors /opt/arcsight/connector_1

Container 2for SmartConnectors /opt/arcsight/connector_2

Setting Default Value
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Appendix C

Restoring Factory Settings

ArcSight Express All-in-One can be restored to its original factory settings using the built-in 
Acronis True Image software.

To restore ArcSight Express All-in-One to its original factory settings, perform these steps:

1 Attach a keyboard, monitor, and mouse directly to the ArcSight Express appliance.

2 Reboot the ArcSight Express appliance using the command line interface.

3 Press any key.

Restoring ArcSight Express All-in-One to factory settings will irrevocably delete 
all event data and configuration settings.
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4 A screen similar to that shown in the figure below will appear on the attached monitor. 
Use the mouse or arrow keys to select System Restore and press Enter.

5 On the Pick a Task list, shown in the figure below, choose Recovery.
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6 The Restore Data Wizard opens. Click Next to continue.

7 Select the Acronis Secure Zone, as shown in figure below. Review the choices you 
make on this page and the wizard pages that follow before initiating the restore 
process.

8 Click Next.
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9 Select Restore disks or partitions and click Next. Choose other options only if 
specifically directed to do so by ArcSight Customer Support.

10 Select the entire drive labeled sda as in the figure below. Click Next to continue.
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11 Select Generate new NT signature in the following screen and click Next.

12 Choose the drive to restore (sda) and click Next.
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13 Select Yes, I want to delete all the partitions on the destination hard drive 
before restoring and click Next.

14 Because there are no other partitions or disks to restore, select No, I do not, on the 
Next Selection page of the wizard. 

15 Click Next.
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16 Validating the archive before restoring is optional. Check the box to validate the 
archive or leave it unchecked to skip this step. Check the box to Restart machine 
automatically if needed for the recovery. Click Next.

17 Review the checklist of operations to be performed and click Proceed to begin the 
restore process, or click Back to revisit previous wizard pages.

Do not interrupt or power-down the ArcSight Express appliance during 
the restore process. Interrupting the restore process may force the 
system into a state from which it cannot be recovered.
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The progress bars shown in the figure below display the status of the current and total 
operations.

When the restoration is complete, an alert is displayed that says "Data was 
successfully restored." 

18 Click OK in the message box and close the Acronis True Image Server window to 
reboot the appliance.
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